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SupportCentre 
 WebEx™ Recorder and Player Guide 
InterCall, a subsidiary of West Corporation, in partnership with WebEx Communications, 
Inc provides SupportCentre web conferencing services. Because SupportCentre is 
powered by WebEx, this guide makes several references to the company name, platform 
and features. 

This guide assumes that you have a SupportCentre user account and are set up to host 
sessions. 

Introducing the WebEx Recorder and Player 
Use the WebEx Recorder to create a video recording of all screen activity on your 
computer including mouse movements and annotations. You can also capture audio in a 
recorded session such as the audio from an InterCall audio conference. The WebEx 
Recorder is available in these versions: 

 Integrated meeting recorder – As a part of the Support Manager software that you 
use to participate in an online support session, the integrated recorder lets you crate 
video of all on-screen activity- including mouse movements and annotations – that 
occurs during an online support session. You can also capture audio in a recorded 
support session, such as audio in an audio conference. 

 Standalone recorder – Available offline, the Standalone Recorder allows you to 
record all activity in an application. You can also capture audio, such as your 
narration or sounds that play in a file. This standalone recorder is useful for creating 
software demonstrations, tutorials, sales presentations, and so on. You can 
download the standalone recorder from the SupportCentre website at 
www.intercallcentres.com. 

System Requirements for Recorder and Player 
The following are the minimum system requirements for WebEx Recorder and Player: 

 Microsoft Windows 95, 98, Me (Millennium Edition), XP, 2000, or NT 

 Microsoft Internet Explorer 4.x or a later version, or Netscape 4.x or a later version 

Using the Integrated Recorder 
To record an online support session, you can use the integrated Recorder. Once you 
record an online support session for the first time, Support Manager downloads and 
installs WebEx Player on your computer. 

RECORDING AN ONLINE SUPPORT SESSION 
Once you start recording an online support session, the integrated Recorder begins saving 
the recording to a file on your computer. Ensure that you have enough space on your hard 
disk for a recording. 

To capture audio in a recorded session, you must set up your computer’s sound card and 
attach the appropriate audio input device. 
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To start recording an online support session: 
1 On the CSR Dashboard, click the Session tab, and then click Record Session. 

 
You can open the WebEx Recorder only after a customer joins the session. The customer must then grant permission for 
you to record the session. 

2 Choose a location at which to save the recording. 

 

3 In the File Name box, type a name for the file and then click Save. 
The Recorder Panel appears. 

4 4 On the Recorder Panel, click the Record button. 

 

The Progress and file size indicator on the Recorder Panel indicates the current duration of the recording, in hours, minutes 
and seconds; and the current file size of the recording file, in kilobytes. 

To pause and then resume recording: 
1 On the Recorder Panel, click the Pause button. 

 

2 Then, to resume recording, click the Resume button. 
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To stop recording: 
On the Recorder Panel, click the Stop button. 

 
WebEx Recorder saves your recording to a file in the WebEx Recording Format, which has a .wrf extension. 

Using the Standalone Recorder 
To record an application on your desktop offline – that is, outside of an online support session – you must use the standalone 
version of the WebEx Recorder. 

RECORDING AN APPLICATION ON YOUR DESKTOP 
Once you start recording an application on your desktop, the standalone recorder begins saving the recording to a file on 
your computer. Ensure that you have enough space on your hard disk for a recording. 
To capture audio in a recording, you must set up your computer’s sound card and attach the appropriate audio input device. 

To start WebEx Recorder: 
Do either of the following: 

 Click Start, point to Programs, point to WebEx Recorder & Player then click WebEx Recorder. 
 Double-click the WebEx Recorder shortcut on your computer’s desktop. 

 
The WebEx Recorder console appears. 

 
To start recording: 

1 On the WebEx recorder console, click the Open Application button. 
2 In the WebEx recorder - Open Application dialog box, select an application on your desktop. 

 
3 Click Select. 
4 Choose a location at which to save the recording. 
5 In the File Name box, type a name for the file then click Save. The Recorder Panel appears. 
6 On the Recorder Panel, click the Record button. 
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The Progress and File Size indicator on the Recorder Panel indicates the current duration of the recording in hours, minutes 
and seconds and the current size of the recording file in kilobytes. 

 
To pause and then resume recording: 

 On the Recorder Panel, click the Pause button. 

 

To resume recording, click the Pause button again. 

To stop recording: 
 On the Recorder Panel, click the Stop button. 
 WebEx Recorder saves your recording to a file in the WebEx Recording Format which has a .wrf extension. 

To quit WebEx Recorder: 
 On the File menu, choose Exit. 

SWITCHING TO ANOTHER APPLICATION DURING RECORDING 

Once you start recording an application using the standalone recorder you can switch to recording another application 
without stopping WebEx Recorder. Thus, you can create a single recording that captures your actions with two or more 
applications in a sequence. 

To switch to another application during recording: 
1 Pause recording. The WebEx Recorder button appears on your computer’s taskbar. 

 
2 Click the WebEx Recorder button to display the WebEx Recorder – Open Application dialog box. 
3 In the list, highlight the application that you are currently recording. 
4 Click Unselect. 
5 In the list, select another application to record. 
6 Click Select. 
7 Resume recording. 
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RECORDING MULTIPLE APPLICATIONS SIMULTANEOUSLY 

Once you start recording a single application, you can start recording another application simultaneously, without stopping 
WebEx Recorder. 

To record multiple applications simultaneously: 
1 Pause recording. The WebEx Recorder button appears on your computer’s taskbar. 

 
2 Click the WebEx Recorder button to display the WebEx Recorder – Open Application dialog box. 

3 In the list, select another application that you wan to record. 

4 Click Select. 

5 Resume recording. 

HIDING THE RECORDER PANEL DURING RECORDING 

Normally, the Recorder Panel appears on your screen during recording. However, before you begin recording, you can 
hide the Recorder Panel. If the Recorder Panel is hidden, you can pause or stop recording by pressing a hot key – that is, 
a key or combination of keys on your computer’s keyboard. 

To hide the Recorder Panel: 
1 On the Recorder console of the standalone recorder, on the Settings menu, choose WebEx Recorder Settings. 

The WebEx Recorder Settings dialog box appears. 

 
2 Under Recorder Panel select the Hide the Recorder panel during recording check box. Default hot keys appear in 

the Pause/Resume and Stop boxes. While recording, you can press the appropriate hot key to stop or pause 
recording. 

3 Optional: To specify your own hot keys, click in the Pause/Resume or Stop boxes and then do one of the 
following: 

a. Hold down the Control or Shift key and then press another key. 

b. Hold down both the Control and Shift keys and then press another key. 

4 Click OK. 

To show the Recorder Panel after it is hidden, during recording, press the hot keys that you specified to either pause or 
stop recording. 

The default hot keys are the following: 

 Pause recording – Ctrl+Alt+P key combination 

 Stop recording – Ctrl+Alt+S key combination. 
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ANNOTATING A RECORDING 
While recording, you can use the highlighter tool to make annotations. Your annotations appear in the recording during 
playback. 

To make annotations while recording: 
Do any one of the following: 

 On the Recorder panel, click the Annotate button. 

 

 In the lower-right corner of your computer’s task bar, click the Recording button. Then, on the menu that appears, 
choose Annotate. 

 In the title bar of the application you are recording, click Recording.  Then, on the menu 
that appears, choose Annotate. 
 An annotation drop down menu button appears on your screen and your mouse pointer changes to a highlighter. 

 

To change your annotation colour: 
1 Click the Annotation drop-down menu. 
2 On the colour palette that appears, choose Annotation Colours. 
3 Select a different colour. 

To exit annotation mode: 
1 Click the Annotation drop-down menu. 
2 On the menu that appears, choose Stop Annotating. 

Inserting Markers into a Recording 
During recording, you can insert one or more markers into a recording. A marker is a placeholder that lets you quickly located 
a position in a recording file when editing it using WebEx Recording Editor. 

For example, if you are recording a SupportCentre session and someone makes an important comment, you can quickly 
insert a marker into the recording at that time. Then, when editing the recording, you can quickly locate the point in the 
recording at which the comment was made. 

You can insert a marker using either the Recorder Panel or a hot key – that is, a key or combination of keys on your 
computer’s keyboard. A hot key is useful if you set up the Recorder Panel to be hidden during recording. 

To insert a marker into a recording using the Recording Panel, on the Recorder Panel, click the Insert Marker button. 
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To insert a marker into a recording using hot key: 
1 On the Recorder console of the standalone recorder, on the Settings menu, choose WebEx Recorder Settings. The 

WebEx Recorder Settings dialog box appears. On the Recorder Markers tab, a hotkey appears in the box. While 
recording, you can press this hot key to insert a marker. 

 
2 Optional. To specify your own hot key, click in the box and then do one of the following: 

a. Hold down the Control or Shift key, and press another key. 
b. Hold down both the Control and Shift keys, and then press another key. 

3 Click OK. 

Recording Audio 
WebEx Recorder automatically synchronises audio with your sequence of actions in an application or session. In order to 
capture audio, you will need a phone line. This can be a direct phone line or an audio conference line. 

SYSTEM REQUIREMENTS FOR RECORDING AUDIO 
To record audio, ensure that your computer meets the following system requirements: 

 Intel Pentium III 667 MHz or faster 
 128MB RAM or more 
 Creative Labs Sound Blaster or equivalent sound card 
 Input device for capturing audio 

NOTE: Use an input device that is appropriate for the type of audio that you want to capture. 
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INPUT DEVICES FOR RECORDING AN AUDIO CONFERENCE 

To record an audio conference for an online support session, you must connect the recording computer to a telephone using 
one of the following: 

 Phone recording adapter – Connects your phone to your computer’s sound card. A phone recording adapter captures 
all audio in a teleconference. The following two phone recording adapters from DynaMetric, Inc. are compatible with 
WebEx Recorder: TLP-102 Telephone Logger Patch and TMP-636 Transmit and Receive Patch. To connect a phone 
recording adapter to your computer’s sound card, follow the instructions that DynaMetric provides. 

 

To record audio in rich media files, such as audio and video files, you must use a phone recording adapter that supports 
bi-directional audio between your phone and computer –that is, connects to both the input and output jacks for your 
computer’s sound card. The DynaMetric TMP-636 adapter supports bi-directional audio. 

To purchase a DynaMetric phone recording adapter, please visit the following web address: 
www.dynametric.com/webex_purchasing.html. 

 Universal multimedia amplifier – Connects your telephone to a headset and your computer’s sound card. You can use 
a universal multimedia amplifier as a phone recording adapter to capture all audio in an audio conference. Using a 
universal multimedia amplifier is ideal if you often speak an audio conference, Internet phone conferences and 
standalone recording sessions, because it allows you to switch between a phone headset and a computer headset. 
The following universal amplifier is known to be compatible with WebEx Recorder: Plantronics MX10 Universal 
Amplifier. To record audio in shared files, such as UCF rich media files, you must use a universal multimedia amplifier 
that supports bi-directional audio between your phone and computer – that is, connects to both the input and output 
jacks for your computer’s sound card. The Plantronics MX10 Universal Amplifier supports bi-directional audio. To 
purchase a Plantronics universal multimedia amplifier, please visit the following web address: www.plantronics.com 

 Conference phone with RCA output jack - To capture audio using a conference phone or speakerphone, connect the 
phone’s RCA audio output jack to the microphone input jack on your computer’s sound card. 

NOTE: For better audio quality and convenience, use a phone headset when recording an audio conference. 
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SETTING UP YOUR SOUNDCARD FOR RECORDING AUDIO 
Before you start recording audio, do the following to set up your computer’s sound card: 

1 Select sound card – Select the sound card that you want to use for recording and playing sound, if your computer 
has multiple sound cards. 

2 Adjust audio volume 
a. Adjust the audio input volume for your microphone or phone, which determines the sensitivity of WebEx 

Recorder when capturing audio. 
b. Adjust the audio output volume for your speakers or earphones. 

3 Specify microphone settings 
a. For recording, ensure that the microphone input setting is either selected or not muted, depending on your 

sound card, and that all other input controls are either muted or not selected. 
b. For playback, ensure that the microphone input setting is either not selected or muted, depending on your sound 

card. 
4 You can set up your computer’s sound card in either of two ways: 

 Use the Audio Setup Wizard, which is available in the standalone WebEx Recorder only. The wizard automatically 
specifies the correct recording and playback settings for your microphone. 
 Use your sound card’s volume controls and Windows Sound Recorder to manually set up your sound card. 

To use the Audio Setup Wizard to set up your sound card: 
1 On the WebEx Recorder console, on the Settings menu, choose Audio Setup Wizard. 
2 Follow the instructions in the wizard. 

To set up your sound card manually: 
1 Open your sound card’s volume controls as follows: 

 
a. On your computer’s desktop, click Start 
b. Point to Programs point to Accessories, and then point to Entertainment. 
c. Choose Volume Control. The Volume Control dialog box appears. 

2 On the Options menu, choose Properties. 
3 Optional. If your computer has more than one sound card, in the Mixer device drop-down list, select the sound card 

that you want to use for recording. 
4 Select Playback and then click OK. 
5 In the Volume Controls dialog box, ensure that the Microphone setting is either muted or not selected, depending on 

your sound card. 
6 On the Options menu, choose Properties again. 
7 Select Recording and then click OK. 
8 In the Recording Control dialog box, ensure that the Microphone setting is either selected or not muted, depending 

on your sound card. Leave the Recording Control dialog box open on your screen. 
9 Start Windows Sound Recorder, as follows: 

a. On your computer’s desktop, click Start. 
b. Point to Programs, point to Accessories and then point to Entertainment. 
c. Choose Sound Recorder. 

10 Use Sound Recorder to record your voice as you speak into the audio input device that you want to use when 
making the actual recording. 

 
11 While speaking, adjust the Microphone volume as necessary using the Volume slider in the Recording Control dialog 

box. 
12 Play back your recording. 
13 If the audio is too low, increase the Microphone volume. If the audio is distorted, decrease the Microphone volume. 
14 If necessary, continue recording your voice and adjusting the Microphone volume. 
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FILE SIZE ESTIMATED AND RECORDINGS 

Without audio, WebEx Recorder captures approximately 10MB of video data per hour of recording. However, when recording 
frequent actions in an application or session, WebEx Recorder may capture significantly more data. When recording audio, 
the rate at which WebEx Recorder captures data depends on the audio sampling rate that you select. The following are 
estimates of the data that WebEx Recorder captures for the available audio sampling rates. 

If you set Webex Recorder to this Audio 
Sampling Rate: 

It captures approximately this amount of 
Audio and Video Data per hour: 

G.723 at 8 KHz 15MB 
PCM at 8 KHz 70MB 
PCM at 22 KHz 170MB 
PCM at 44 KHz 325MB 

DISTRIBUTING YOUR RECORDINGS 

Once you complete a recording, you can distribute it in the following ways: 
 Ask your company’s Webmaster to publish your recording on your organisation’s website. Once a visitor to your site 
clicks a link for a recording, a playback server automatically downloads the WebEx Player software to the visitor’s 
computer, if necessary, then streams the recording to the visitor’s computer. By streaming recordings, you allow 
visitors to play recordings without the need to download the recordings onto their computers. For more information 
about streaming a recording, please go to www.intercallcentres.com. 
 Provide your recording file directly to the people whom you want to view it. If they do not have the WebEx Player, they 
can download the WebEx Player installation program from the Recording and Playback page on 
www.intercallcentres.com 

USING WEBEX PLAYER 

Using WebEx Player, you can play back any recording that was made using WebEx Recorder – that is, a WebEx Recording 
Format (.wrf) file. 

INSTALLING WEBEX PLAYER 

If you do not yet have WebEx Player, or want to download the WebEx Player installer for users to whom you want to provide 
a recording, you can download it from www.intercallcentres.com. 

SYSTEM REQUIREMENTS FOR LISTENING TO AUDIO IN A RECORDING 

You can listen to audio in a WebEx Recording Format (.wrf) file, if your computer has the following: 
 a Creative Labs Sound Blaster or equivalent sound card 
 speakers, or headphone jack and headphones 

PLAYING A RECORDING 

You can play a recording that resides on your computer or that is published on a Web site. 

To start a WebEx Player: 
Do either of the following on your computer’s desktop: 

 Click Start, point to Programs point to WebEx Recorder & Player, and then click WebEx Player. 
 Double-click the WebEx Player shortcut on your computer’s desktop. 
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The WebEx Player console appears. 

 

To play a recording that resides on your computer: 
Do either of the following: 

 Double-click a WebEx Recording Format (.wrf) file. WebEx Player starts and plays the recording automatically. 
 On the WebEx Player console, click the Open button, and then select a recording. Then, on the WebEx Player 
console, click the Play button. 

 

To play a recording that is published on a website: 
 Go to the web page on which the recording is published, and then click the link for the recording. WebEx Player plays 
the recording automatically. 

To pause and then resume playback: 
 To pause playback, on the WebEx Player console, click the Pause button. 

 

 Then, to resume playback, on the WebEx Player console, click the Pause button again. 

To automatically repeat (loop) playback: 
 On the WebEx Player console, on the Controls menu, choose Loop. 

To stop a playback: 
 On the WebEx Player console, click the Stop button. 

 

To quit WebEx: 
 On the WebEx Player console, on the File menu, choose Exit. 
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NAVIGATING AND RECORDING 

When playing a recording, you can fast forward or rewind the recording. If segments were defined in the recording, you can 
navigate to a specific segment. 
To fast forward playback: 
Do either of the following: 

 To browse a recording while fast forwarding it, click the Forward button. Each click moves the recording forward 
incrementally. 

 

 To fast forward a recording to a specific location, drag the playback slider to the right. 

 

To rewind a recording: 
Do either of the following: 

 To browse a recording while rewinding it, click the Rewind button. Each click moves the recording backward 
incrementally. 

 

 To rewind a recording to a specific location, drag the playback slider to the left. 

 

To navigate to the next or previous segment: 
Click the Previous Segment button or Next Segment button, as appropriate. 
NOTE: If no segments were defined in the recording, the Previous Segment and Next Segment buttons are unavailable. 

To navigate to a specific segment: 
1 On the Controls menu, point to Segment. 
2 Choose Go to. The Go to Segment dialog box appears. 

 
If segments were defined in the recording, they appear in the list. 

3 In the list, select a segment. 
4 Click OK. 
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CONTROLLING FULL-SCREEN VIEW OF PLAYBACK 

During playback, you can switch your view of a recording between a standard window and a full-screen view. A full-screen 
view of a recording fits your entire screen and does not include a title bar or scroll bars. You can also set WebEx Player to 
display all recordings in a full-screen view by default. 

To display a recording in full screen view: 
 Click the Full Screen button. 

 

To display a recording in a standard window: 
 Click the Full Screen button again. 

To display all recordings in a full-screen view by default: 
1 If you have not done so already, open a recording file (.wrf). 
2 On the WebEx Player console, on the Controls menu, choose Settings. The Playback Settings dialog box appears. 

 

3 Under Full Screen Setting, select the Play back in full screen mode by default check box. 
4 Click OK. 

ADJUSTING AUDIO DURING PLAYBACK 
During playback of a recording, you can increase or decrease the audio volume, or mute or unmute audio. 

To adjust playback volume: 
Drag the Volume slider to the right or left to increase or decrease volume, respectively. 

 
To mute audio: 
+ Click the Mute button. 

 
To unmute audio: 

+ Click the Unmute button.  
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HIDING OR SHOWING THE PLAYER CONSOLE 

Normally, the WebEx Player console appears on your screen when you are playing a recorded session. However, you can 
hide the WebEx Player console during playback. If the WebEx Player console is hidden, you can pause or stop playback by 
pressing a preset hot key – that is, a key on your computer’s keyboard. 

To hide the Player console during playback: 
1 If you have not done so already, open a recording file (.wrf). 
2 On the WebEx Player console, on the Controls menu, choose Settings. The Playback Settings dialog box appears. 

 

3 Under Player console settings, select the Hide Player console during playback check box. 
4 Click OK. 

While the WebEx Player console is hidden, you can: 
 pause and resume playback by pressing the Ctrl+Alt+P key combination on your keyboard 
 stop playback by pressing the Ctrl+Alt+S key combination on your keyboard 

To make the WebEx Player console appear after it is hidden: 
1 During playback, pause or stop playback by pressing the Ctrl+Alt+P or Ctrl+Alt+S key combination on your 

keyboard, respectively. 
2 Optional - To keep the WebEx Player console visible, do the following: 

a. On the WebEx Player console, on the Controls menu, choose Settings. 
b. Under Player Console Settings, clear the Hide the Player Console during playback check box. 
c. Click OK. 

UNINSTALLING THE WEBEX RECORDER AND PLAYER 

You can remove the standalone version of WebEx Recorder and WebEx Player from your computer, using your computer’s 
Add/Remove Programs utility. Uninstalling the software does not remove any recordings that reside on your computer. 

To uninstall WebEx Recorder and Player: 
1 Open the Windows Add/Remove Programs utility on your computer. 
2 In the list of programs, select WebEx. 
3 Click Change/Remove 
4 In the Uninstall WebEx Software dialog box, select Support Manager. 
5 Click Uninstall. 

For additional information about the WebEx Recorder and Player capabilities with SupportCentre, please contact InterCall 
Account Manager. 
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